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I n t r o d u c t i o n

INTRODUCTION
With Site Builder, you can create a range of Web pages, from the simple to the 
sophisticated. In these seven lessons, you will begin by producing simple Web pages. 
Specifically, you will

Lesson 1—Open, translate, and view a sample publication

Lesson 2—Create a new publication

Lesson 3—Learn about templates and global settings

Lesson 4—Learn about elements, styles, and patterns

Lesson 5—Apply formatting

Lesson 6—Create a table of contents (TOC) for a publication

Lesson 7—Add navigation buttons

Each lesson introduces you to important features of Site Builder. Once you’ve acquired 
the skills needed to create simple Web pages, you can continue with the Tutorial for an in-
depth look at what Site Builder can do. 

ABOUT CONCEPTS AND TERMS
As you work through these lessons, you will encounter concepts and terms that are either 
specific to Site Builder or are used in Site Builder in a special way. It’s important that you 
understand them. If, during a lesson, you find yourself unsure about a particular concept or 
term, you might want to revisit the Getting Started manual, in particular, the section “Key 
terms” at the end of the Chapter 2, “How Site Builder Works.” In addition, a complete 
glossary of terms is available online (choose Glossary from the Help menu).
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If the interface becomes confusing to you at any time, you might want to review Chapter 
1, “Introducing Content Publisher.” 

COMMAND OPTIONS
In Site Builder there is often more than one way to choose a command. Most commands 
are available from both the menu bar and the standard toolbar, and in some instances there 
are additional options. For example, to open an existing publication, you could do any of 
the following:

Startup Screen—Select Open an existing publication and click OK.

Toolbar—Click Open ( ).

File menu—Choose Open.

Keyboard shortcuts—Crtl+O or Alt, F, O.

In these lessons, we will use just one way (mostly clicking buttons on the toolbar). If 
you’re more comfortable with an alternative method, feel free to use that, instead.

ABOUT STYLES AND PATTERNS
Site Builder works best when your source documents contain either named styled content 
or manually formatted content. A named style is where you create a style by defining a set 
of formatting characteristics and giving those characteristics a specific style name. (You 
can then apply the style at any time by selecting one or more paragraphs in the document 
and selecting the style name from a list of styles.) Manually formatted content is where 
you select text and change its look, or attributes, by applying the different characteristics 
(font size, bold, italic, etc.) individually. 

In Site Builder, a source document is either styled or manually formatted (we sometimes 
refer to the latter as “unstyled”). We refer to named styles simply as styles. When a 
manually formatted document is brought into Site Builder, patterns are created by Site 
Builder to identify the distinct, manually formatted content. Site Builder works best where 
styles or patterns are consistently applied to a source document. Since a manually 
formatted source document is often more difficult to format than one with styles, you’ll be 
working with a patterned or “unstyled” document in this series of lessons.
I-2 Content Publisher: Seven Easy Lessons



For example, one source document may contain the named styles Title, Heading 1, 
Heading 2, and Body Text, whereas another may have the same hierarchy imposed by 
manual formatting. (That is, the content of the second document is completely in the 
Normal style, with the title formatted with the same characteristics as the Title style in the 
first document, and so on.)

Site Builder can analyze such disparity in formatting and create ranks that will allow you 
to apply consistent formatting across all documents. This is explained in the Tutorial 
(available from the Help menu and also the Startup Screen).

Note: Site Builder also has the ability to apply “ranks” to source documents. This can be 
especially useful when you have a number of source documents where the hierarchy of 
their content is clearly delineated within each document but is not consistent between 
those documents.
Content Publisher: Seven Easy Lessons I-3





L e s s o n

A SAMPLE PUBLICATION
In this lesson, you will learn how to

! Open an existing publication

! Translate the source document contained in that publication

! View the Web page produced as a result

Beginning in Lesson 2, you will learn how to create the Web page you will view at the end 
of this lesson. 

KEY CONCEPTS
When you start a project in Site Builder, you begin by working in the root publication, 
which contains one or more source documents, any optional reference pages you choose to 
build, and the templates you use to format the source documents and reference pages. The 
root publication can contain other publications, which become subpublications of the root 
publication and, together with the root publication, form a publication hierarchy. You will 
learn about creating a publication hierarchy in the Tutorial. In these lessons, you will work 
with a simple publication.

When translated, the publication becomes a Web publication, consisting of one or more 
Web pages for each source document and any reference pages you create. Each 
publication has its own project file, which is used to save important details. 

When Site Builder translates a source document, it takes the content of the document, 
reformats it per your instructions in the template, and produces an HTML file, which it 
places in a designated output directory. (The source document remains unchanged.) That 
file is the Web page you view in your Web browser. Reference pages are different. They 
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A Sample Publication
are built by Site Builder during translation and derive their content from the source 
documents. 

EXERCISE
If the Startup Screen is open in the main window of Site Builder (see figure below), note 
that your options include the ability to open an existing publication or to specify the last 
publication you used. Click Cancel to close the screen.

Figure 1-1 Startup Screen

The Startup Screen is opened in the main window each time you start Site Builder. If you 
click “Don’t Show This Screen Again,” you can open the Startup Screen at any time from 
the Help menu.

Before we begin, take a quick look at the main window. In the Publication Hierarchy pane 
you’ll see “<Unnamed>,” and just above the Contents pane you’ll see “Contents of: 
<Unnamed>”. These two places are where the name of your publication always appears. 
On the title bar you’ll see “Unsaved – Site Builder.” This is where the name of the project 
file always appears.

Let’s open an existing publication, which we do by opening its project file.
1-2 Content Publisher: Seven Easy Lessons



A Sample Publication
Opening an Existing Publication
To open an existing publication, perform these tasks:

1. Click Open ( ) on the toolbar.

2. If the Select a Repository dialog box opens, click Don’t show this dialog box again, 
accept the default File System, and click OK.

3. In the Open dialog box, locate the Samples folder in the Content Publisher directory. 
(If you accepted the default directory during installation, the path is C:\Program 
Files\Stellent Content Publisher\Samples\en.) 

4. Select Lessons.tcp from the file list and click Open. Site Builder opens the project 
file Lessons.tcp.

Note how the main window has changed. The name of the project file appears in the title 
bar. The name of the publication, which also happens to be Lessons (but doesn’t have to 
be), appears in the Publication Hierarchy pane and also above the Contents pane. In the 
Contents pane are details about the publication. In Site Builder, a publication can contain 
many documents. Our sample is a simple publication that contains just one source 
document and one reference page. Each has its own template. (You’ll learn more about 
templates later.)

To see the full path and file name for the source document, place the mouse on the divider 
that separates the Source and Template columns. When the cursor changes from an arrow 
to a cross, move the divider to the right. You can adjust the width of the other columns in 
the same way. You can also improve your view of the Contents pane by dragging the large 
toolbar and repositioning it on the desktop or by hiding it altogether (by choosing Large 
Toolbar from the Toolbars submenu of the View menu).

You now want to turn the source document into a Web page.

Translating the Publication
To translate the publication, perform these tasks:

1. Click Translate ( ) on the toolbar. The Update Versions dialog box opens.

The toolbar button is for an incremental translation, which will suffice in most 
instances. (It’s the same as a full translation the first time you translate any project.) 
To ensure a full translation for a project that has previously been translated, use the 
Translate All command on the Run menu.

2. In the Update Versions dialog box, accept the default and check Don’t show this 
dialog box again.
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A Sample Publication
This dialog box is relevant only when your project contains Directory Items (see the 
Tutorial, Lesson 15, for more information).

Once you translate the source document, you can open your Web browser to view the Web 
page you created.

Viewing the Web Page
To view the Web page, perform these tasks:

1. In the Contents pane, select the source document.

2. Click View ( ) on the standard toolbar.

Figure 1-2 Site Builder main window

The Site Builder main window, showing publication details. If you click below the list of 
publications in the Contents pane, you will deselect any output page that is already 
selected. If you then click View, your Web publication will open at the first output page in 
the list of files—in this case, the TOC.

Your Web browser displays the Web page you just created. At the top of the Web page 
click the TOC button to jump to the Table of Contents (see Figure 1-3). This is the Web 
page that Site Builder created from the Table of Contents reference page shown in the 
Contents pane. 
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A Sample Publication
Figure 1-3 Table of contents for the Lessons publication

The two-part title of this table of contents for the Lessons publication is composed of the 
publication name and the default document title for the TOC.

Navigation buttons like this TOC button are common in Web publications and are easy to 
add in Site Builder. In the TOC page, you can see a title and some blue hot spot text. The 
title, “Lessons Table of Contents,” has two components: “Lessons” is taken from the 
publication name, and “Table of Contents” is the default title that Site Builder assigns to 
every TOC. You’ll learn more about titles in the Tutorial. The blue hot spot text comes 
from headings in the source document. Click one of these headings—say, “Source 
Documents”—and you’ll return to the Web page for the source document itself. 

SUMMARY
You’ve just opened a project file, translated the source document for the publication, and 
viewed the resulting Web page in your Web browser. You also viewed a simple table of 
contents that was created automatically by Site Builder, using content derived from the 
source document. This is a simple publication, which you’ll now create from scratch on 
your own in the following lessons. 
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A Sample Publication
Once you learn how to set up a publication, you’ll discover that updating your Web page 
can be as easy as

! Revising your source document in its native format

! Opening your project file

! Translating and viewing the publication

In the next lesson, you’ll learn just that, as you create a new publication and select source 
documents for translation.
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L e s s o n

CREATING A NEW PUBLICATION
In this lesson, you will learn how to start a new project and create your own Web pages. 
Specifically, you will

! Start a new project

! Name the project file 

! Add a source document to the root publication

! Create a new template

! Translate and view the publication

KEY CONCEPTS
When you add a source document to a publication, you associate a template with that 
document. If it is a styled document, Site Builder can import the styles from the document. 
If it is a manually formatted document, Site Builder can identify patterns in the document 
and import these, instead. (Site Builder can also apply “ranks” to source documents, which 
is discussed in the Tutorial.) Site Builder associates each style or pattern with an element, 
which it generates automatically, and places the elements in the template. You can 
associate only one template per document, but you can associate the same template with 
many different documents.

You use the elements to format the content of your source document and to determine the 
look of the Web page you create. The formatting instructions are saved in the template, 
which, in turn, is saved in the project file.
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Creating a New Publication
EXERCISE

Starting a New Publication
To start a new publication, perform these tasks:

1. Click New ( ) on the toolbar. If you didn’t close Site Builder after Lesson 1, Site 
Builder will prompt you to save the project file Lesson.tcp. Click Yes.

The Publication Properties dialog box now opens. Here, you can name the publication 
and specify directories for output files. The default output directory is C:\Documents 
and Settings\<username>\My Documents\Stellent\Output. But you can place the files 
in any drive or directory, local or network. And you can use different directories for 
output pages and graphics.

2. Type MyLesson in the Publication Name text box and also in the Publication Title 
text box. Typically, you’ll want to use the same name for both the publication name 
and title, but you don’t have to. (You’ll learn about titles in the Tutorial.)

Change the output directories for pages and graphics if you want to use a location 
other than the default directories shown.

3. Click OK.

You have named your new publication. The new name appears in the Publication 
Hierarchy pane and just above the Contents pane. But the title bar still reads “Unsaved.” 
That’s because Site Builder lets you name a publication and its project file differently, and 
you have not yet named the project file.

Renaming the Project File
To name the project file, perform these tasks:

1. Click Save ( ) on the toolbar.

2. The Save As dialog box opens, with the default project file name MyLesson.tcp 
(based on the publication name) highlighted in the File Name text box. Type 
MyProjectFile and then locate and open the Samples folder in the Content Publisher 
directory (where Lessons.tcp is). You don’t have to give a project file the .tcp 
extension. Site Builder will do this for you.

3. Click Save. Site Builder has saved the new project file, with the .tcp extension. The 
name of the project file appears in the title bar.
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Creating a New Publication
The next step is to tell Site Builder which source document you want to turn into a Web 
page.

Selecting a Source Document
To select a source document, perform these tasks:

1. Click Add Document ( ) on the toolbar.

2. The Add Document dialog box opens. In this dialog box you select the document you 
want to add to your publication. Browse to the ..\Stellent Content 
Publisher\Samples\en subdirectory and open the Formatted folder (see Figure 2-1).

3. Select Source Documents.doc and click Open. The Add Document dialog box 
closes. You may then see several progress dialog boxes appear briefly onscreen as Site 
Builder loads the browser controls to prepare the Preview window for the Choose 
Template dialog box, which then opens.

Figure 2-1 Add Document dialog box

.

This is where you select documents for translation.

When the Choose Templates dialog first opens, it displays a default translation of the 
source document in the Preview window (see Figure 2-2). This is done using the Academy 
template, the first template in the Templates list. You can select any other template from 
the Templates list to associate with the source document or create a new template. 
Content Publisher: Seven Easy Lessons 2-3



Creating a New Publication
Figure 2-2 Choose Template dialog box

If the Auto check box under Preview Updates is selected, the Preview window 
automatically displays a temporary translation of the source document.

To see how template settings can affect the look of a source document when the document 
is translated, select another template from the list, for example, Administration. As soon as 
you do so, Site Builder retranslates the source document, this time applying the settings 
from the Administration template. You can see the results in the Preview window. Site 
Builder did this automatically because the Auto check box under Preview Updates is 
selected by default. You can clear this check box, if you prefer, and use the Update Now 
button to selectively update the template settings in the Preview window.

Note: What you see in the Preview window in the Choose Template dialog box (and also 
in the Edit Template dialog box) are temporary translations done solely for preview 
purposes. These are placed in temporary files and are not available for viewing in your 
Web browser. In other words, having used this Preview window to help you edit templates 
and create Web pages to your liking, you must still return to the main window to translate 
the source documents and create output pages for viewing in your Web browser.

In this lesson you are going to create a new template for your document. When you work 
with a document that has been manually formatted, it is sometimes best to start with a new 
template, since the settings in the templates available in the Templates list may not exactly 
fit your needs.

Creating a New Template
To create a new template, perform these tasks:

1. In the Choose Template dialog box, click the New button above the list of templates to 
open the New Template dialog box.
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Creating a New Publication
2. Type MyTemplate in the text box, and make sure that Body is selected under 
Template Type. Don’t base the new template on another template. Just click OK. 

In the Choose Template dialog box you will now see MyTemplate already selected in 
the Templates list and therefore associated with the source document. That’s why a 
rather plain Web page now displays in the Preview window. 

3. Under Import Styles or Patterns, at the top of the Choose Template dialog box, select 
Patterns.

If you had accepted the default None, Site Builder would have imported neither styles 
nor patterns from the source document. Moreover, it wouldn’t have created ranks, 
either (ranks are an alternative to styles and patterns), because you are creating a new 
template, not using an existing template in the Choose Template dialog box. This is 
explained in the Tutorial. For now, note that we have instructed Site Builder to import 
patterns from our manually formatted source document.

4. Click OK.

The Progress dialog box appears briefly as Site Builder imports patterns from the 
source document. Site Builder creates an element for each pattern and places the 
elements in the new template MyTemplate. (You’ll learn more about elements later.) 
The Choose Templates dialog box closes and you return to the main window, where 
the source document is now listed in the Contents pane, with the name of the new 
template MyTemplate in the Template column.

You have now done the minimum necessary to create a Web page: created a 
publication containing a single source document and associated a template with that 
document. The next step is to translate your publication. But first you should save 
your project file. 

5. Click Save ( ) on the toolbar.

You’re now ready to translate the publication as you did in the last lesson.

Translating and Viewing the Publication
To translate and view the publication, perform these tasks:

1. Click Translate ( ) to translate the source document.

The File Conflicts Notice dialog box opens. This is simply telling you that you already 
have an output file with the name that will be used when you translate the source 
document in the MyLesson publication. That’s because the publication you translated 
in the last lesson contained the same source document and also because you’re using 
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Creating a New Publication
the same (default) directory for your output files. This warning prevents you from 
accidentally overwriting output files. Click OK and the translation will continue.

2. In the Contents pane, click View ( ) on the large toolbar. 
(If Internet Explorer is your default browser, the IE icon will display on the large 
toolbar, instead.)

Take a look at the Web page you have just created (see Figure 2-3). It is the same one you 
previewed in the Choose Templates dialog box, and much simpler than the one you 
viewed in Lesson 1.

Figure 2-3 Your first Web page, as it appears in the Web browser, with no special formatting

SUMMARY
The Web page you just created is quite simple. It lacks navigation buttons, separators that 
could help structure the content, icons that might be used for special effects, and even a 
background color or graphic. But in creating it, you completed the steps necessary to 
create any Web page in Site Builder: started a new project, named the project file, added a 
source document to the root publication, created a new template, and translated and 
viewed the resulting Web page in your Web browser.

As you continue through these lessons, you’ll learn how to create Web pages like the one 
in Lesson 1. Keep your Web browser open if you plan to start Lesson 3 right away. 
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Creating a New Publication
Otherwise, save the project file before you leave Site Builder. You’ll need it for the next 
lesson.

Tip
You don’t have to use the Add Document dialog box to add source documents to a 
publication. You can drag files from the folder hierarchy in Windows Explorer and simply 
drop them into the Contents pane in Site Builder (the Choose Template dialog box will 
open each time).
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L e s s o n

TEMPLATES AND GLOBAL SETTINGS
In this lesson, you will learn how to

! Select a graphics set from the gallery

! Insert copyright information and an email address

These two seemingly unrelated tasks have something in common: they are both global 
settings. As you edit a template to turn a source document into a Web page, you typically 
edit the individual elements in the template. But some instructions are set for the template 
as a whole, rather than for individual elements. 

KEY CONCEPTS
Most of the options that affect your Web page globally are to be found on the Globals 
property sheet. One of the most important is the opportunity to pick a graphics style to use 
for the background, navigation buttons, separators, and other visual elements you use to 
design Web pages. 

Site Builder comes with a large number of graphics, most of them arranged in matching 
Sets that can be picked from the Gallery. You can begin to appreciate these by entering the 
Choose Template dialog box for a selected template and switching between templates. 
Except for Blank, each template in Site Builder has a graphics Set associated with it. So by 
doing this, you will be able to view a selection of the graphics available in Site Builder. 

Since graphics are used in many different ways in Site Builder, you can open the Gallery 
from three of the property sheets: Formatting, Navigation, and Globals. In Globals you 
can not only pick a Set, but also make it the default Set to be used automatically 
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throughout your publication for the selected template. As a result, you don’t have to search 
for a particular graphic each time to ensure a consistent look for your Web publication.

Graphics Sets are therefore associated with specific templates in your Web publication. 
Likewise, adding a copyright line to your Web page and including an email address are 
template-based settings.

EXERCISE
1. Open MyProjectFile.tcp, the project file you created in the last lesson.

Remember: the project files used in your most recent sessions in Site Builder are listed 
at the bottom of the File menu.

2. In the Contents pane, select Source Documents.doc.

3. Click Edit Template ( ) on the large toolbar to open that dialog box 
(see Figure 3-1).

The four editing commands down the right side of this dialog box are the same ones 
found in the Template menu and on the Template toolbar. We could have opened 
Globals directly from the menu or toolbar. The advantage of working in this dialog 
box is that you can move easily between the editing options offered by all four 
commands. 

Figure 3-1 Edit Template dialog box

If the template is associated with more than one source document, you can click Change 
Preview to select one of the other source documents to view, instead.
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Another advantage of the Edit Template dialog box is that the Preview window lets you 
see the changes to your template as you make them. (As you entered the dialog box, you 
may have noted that Site Builder displayed several progress dialog boxes as it loaded the 
browser controls for the preview and created a temporary translation file in order to 
display your source document as a Web page in this window.) Moreover, editing is 
simplified because as you pass your cursor over the Preview window, tooltips identify the 
names of the elements associated with the content of your source document. Try this now.

Selecting a Graphics Set
To select a graphics set, perform these tasks:

1. Click Globals ( ) to open that property sheet.

2. Click Set to open that tab dialog. (You may have to click one of the arrow buttons at 
the upper right of Globals to display the Set tab.) Then click Gallery.

Figure 3-2 The Gallery

When you open the Gallery from the Set tab dialog in Globals, you are automatically 
in the Sets mode. (The Groups mode is available only when you enter the Gallery 
from Formatting or Navigation.)

3. From the list of Sets, select several, in turn. Note how distinctive the designs are. 
The buttons you see are for navigation (which we address in Lesson 7). Each Set 
also includes a separator, bullet, and background effect.

4. Select Maroon Sand.

5. Click the Make Default button to make this Set the default (its name is now bolded).
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6. Click OK to return to the Set tab dialog.

7. Click Apply Set Selection, and click Yes when asked whether you want to apply the 
new default Set.

Figure 3-3 Applying the set selection

You have now picked a graphics Set and applied it to your template to replace any other 
Set you might have been using already. You have also simplified your choice of graphics 
throughout Site Builder, because graphics from the default Maroon Sand Set will now be 
applied automatically whenever you select a navigation button, or any graphic, that is 
available from the Set.

The Globals property sheet with the Set tab dialog open. You can use the two arrow 
buttons at the upper right to scroll through all the tabs available.

In fact, the background graphic of this Set will be used automatically in your template. 
You can confirm this by switching to the Colors tab dialog (click one of the arrows to the 
upper right of Globals, if necessary, to display the Colors tab). Under Background Colors, 
Use a background graphic is already checked and the path and name of the graphic 
displays in the File Name text box. In addition, the background graphic can be viewed in 
the Sample box.

Because you chose Maroon Sand as the default graphics Set, Site Builder automatically 
picks the background graphic from this Set. All Web pages created with this template will 
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have this background graphic. Site Builder will do this for most graphic elements within 
the Set. Later, you’ll turn on the navigation buttons. 

Let’s turn to the second global task.

Inserting Copyright and E-Mail Address Information
To insert copyright information and an email address, perform these tasks:

1. Click Address to open that tab dialog.

2. Under Address Lines, type Copyright 2006 in line 1.

Figure 3-4 Address tab dialog in Globals

You don’t have to enter an actual address in the address lines. In fact, you can enter 
any information.

3. Under Email Lines, make sure that Include Email Address is checked. In the Email 
Prompt text box type Email Comments, and in the Email Address text box type 
Youremail@youraddress.extension.

You have now added a copyright line and an email address to the Web page.

4. Click OK to return to the Edit Template dialog box.

Since Auto, under Preview Updates, is the default setting, the Preview window 
immediately updates your source document. Note the new background, taken from the 
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Maroon Sand graphics Set. Scroll to the bottom of the page and you’ll see the two 
lines you added. “Email Comments” is in blue hot spot text.

Though it’s not evident, you can format the copyright line because a global element is 
assigned to Address information by default. We explain this element in the next 
lesson.

5. Click OK to return to the main window. 

You have saved all your changes to the template. 

6. Choose Save from the File menu or click Save ( ) on the toolbar.

You have now saved the template, and these changes, to the project file.

SUMMARY
You have just had a brief introduction to global settings available in Site Builder. The 
judicious use of graphics can transform an ordinary Web publication into one that’s stylish 
and professional looking. With its 28 pre-designed graphics Sets, each with its own 
distinctive look, Site Builder lets you create professional-looking Web pages with 
minimal effort. Global settings can be important, too, and Site Builder offers many global 
options in the Globals property sheet.

Tip
Moving between the four property sheets from the Edit Template dialog box, as opposed 
to the Template toolbar on the main screen, can be especially helpful when you are doing 
a great deal of formatting on a new publication and want to quickly check the effect of 
your changes. Remember to pass your cursor slowly over the Preview window to display 
tooltips that will identify the elements you want to edit.
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ELEMENTS, STYLES, AND PATTERNS
In this lesson, you will learn how to

! Check the patterns that Site Builder identifies in a manually formatted source 
document and create a new pattern for specific content

! Add a new element

KEY CONCEPTS
When you add a source document to a publication, you have the option in the Choose 
Templates dialog box of accepting the default None, under Import Styles or Patterns, or 
choosing Styles or Patterns, instead. If you choose Styles, Site Builder automatically looks 
for styles in the document. (By “style” we mean a set of formatting characteristics that are 
saved and given a name so that they can be applied to any paragraph in a source 
document.) If you choose Patterns, Site Builder tries to identify patterns in the way that 
formatting characteristics have been applied manually to the content. (By “pattern,” we 
mean a set of font attributes that suggest the hierarchy of content in a source document. 
See “Key terms” in Chapter 2 of the Getting Started manual for more details.)

How successful Site Builder is in recognizing patterns in a document is a function of how 
distinct the patterns are. That’s why it’s always best, when Site Builder imports patterns 
from a manually formatted document, to check the patterns before you start editing the 
template. Often, you may find that you have to create a new pattern (and element) to 
handle a specific portion of the content.

When Site Builder identifies patterns in a source document, first, it names them Pattern1, 
Pattern2, Pattern3, etc., in the order in which they appear in the document. Second, it 
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determines the top three heading levels and assigns the elements Title, Heading 1, and 
Heading 2 to these patterns. Third, it assigns Default Paragraph, a special element, to all 
other patterns. Finally, it assigns an HTML tag to each element.

The element name becomes a marker, or handle, for all content associated with the 
corresponding pattern in the source document. Site Builder stores this information in a 
template, which is saved as part of the project file. When you import a document with 
styles, the process is similar, except that Site Builder generates an element for each style. 

EXERCISE
The changes you’ll make to the template in this lesson are all done in the Element Setup 
property sheet. First, select Source Documents.doc in the Contents pane. Note that the 
Template commands are now active.

To open the Element Setup property sheet, click Element Setup ( ) on the toolbar.

The Element Setup property sheet opens with the Elements tab dialog in front (see 
Figure ). Opposite each element, in the In Body and In Page TOC columns, is a green 
check mark or red cross to denote whether the content associated with that element has 
been assigned to the body page and/or the page TOC. (You’ll learn about Split and 
Promote As in the Tutorial.)

Note: When importing patterns, Site Builder applies the Title element only if the highest-
level pattern appears only once in the document (it doesn’t matter where). Otherwise, the 
elements used would be Heading 1, Heading 2, and Default Paragraph.

Note: With the default None selected in the Choose Template dialog box, Site Builder 
applies a default set of “ranks” to content instead of importing styles or patterns. See Tips 
at the end of this lesson.
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Figure 4-1 Element Setup property sheet

Because your source document has been manually formatted, the first step is to check the 
patterns that Site Builder identified in the document and imported. The list of elements in 
the Elements tab dialog lists more elements than were imported from the source 
document. Two Default elements are assigned by Site Builder to every template. In 
addition, three “system” elements are also included in every template. We can ignore these 
for the moment.

Checking Patterns
To check the patterns that Site Builder identified, perform these tasks:

1. Click Patterns to open that tab dialog.

Here, you’ll see that Site Builder has assigned four elements to the four patterns it 
identified in the source document (see Figure 4-2). The patterns are listed in their 
order of importance (headings first). Thus, while Heading 1 is listed second in the 
Element column, its name, Pattern3 (in the Pattern column), tells us that it was 
actually the third pattern that Site Builder identified in the source document.

Click each pattern, in turn, and note how the information at the bottom of the tab 
dialog changes. The Pattern Details box lists the formatting characteristics for each 
pattern, while the Sample box to the left displays sample text. 
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Figure 4-2 Patterns tab dialog in Element Setup

Patterns are listed in their order of importance in the document hierarchy (the Element 
column), but are named in the order in which they appear in the document (the Pattern 
column).

Site Builder has identified three headings in the source document: Title, Heading 1, and 
Heading 2. It has assigned the element Default Paragraph to the remaining body text in the 
document. However, a closer look at Heading 2 (select the heading and check the Pattern 
Details box) reveals that the text for this portion of the source document is 11 point italic. 
Moreover, as you may recall from viewing the document in the Preview window in Edit 
Template, this isn’t really a heading at all. Rather, it is an introductory paragraph of text 
immediately following the title.

This is an example of the sort of thing you need to review in Element Setup when you 
first import patterns from a source document. Ideally, you should assign a different 
element to Pattern2, one that better describes its content and will make more sense when 
you start editing the template. To do this, you must first create a new element for the 
introductory text. 

Adding a New Element
To add a new element, perform these tasks:

1. Click Elements to open that tab dialog.

2. Click New to open the New Element dialog box.

3. In the Name text box, type Introtext, and click OK.
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In the Elements tab dialog, the new element Introtext now appears in the lower part of 
the Element list. It is grayed out to denote that it isn’t currently assigned to any 
pattern.

4. Click Patterns to open that tab dialog, select Pattern2, and click Association.

The Change Pattern Associations dialog box opens with a list of all the elements 
available in the template.

5. From the drop-down list of elements, select Introtext, and then click OK.

In the Patterns tab dialog, Introtext appears opposite Pattern2. You have successfully 
reassociated the introductory text with the new element.

6. Click the Elements tab. Introtext is now listed in the top portion of the Elements list 
because it’s now an active element. At the same time, Heading 2 is now grayed out, in 
the lower part of the list, because it is 
no longer assigned to a pattern.

7. Click OK to leave Element Setup and save your changes to the template.

8. In the main window, choose Save ( ) from the File menu to save the template to 
the project file.

SUMMARY
In this lesson you had an introduction to the Element Setup property sheet. It’s always 
wise, when setting up a new publication, to spend a little time here to be sure that the 
styles or patterns you have imported are set up the way you want them to be.

The list of elements contains three we haven’t discussed: Address (System), Email 
(System), and Title (System). These are global elements, assigned specific purposes in 
Site Builder. 

In Lesson 3 you created a copyright line (in the Address tab dialog of Globals), which 
appears in the Web page in the default font style (Times Roman, italic). If you like, you 
could select the Address (System) element in Formatting to format this address line. 
However, since the <ADDRESS> tag is assigned to this element by default, any content 
associated with this element will always appear in italic, because that’s how browsers 
interpret this tag. You could, instead, associate the <P> tag with this element to give you 
total freedom in formatting the content.
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The text “Email Comments” that you also added to your Web page can be formatted by 
selecting the special element Email (System). You will learn about Title (System) in 
Lesson 6. (It is also discussed in Lesson 8 of the Tutorial.)

Tips
! To import styles or patterns from a source document, you must formally select Styles 

or Patterns in the Choose Template dialog box. With the default setting of None, Site 
Builder uses a default set of ranks to handle content hierarchy (see below).

! Typically, you will want to select Styles when all your source documents are styled. 
Likewise, Patterns is the best choice if all your source documents are manually 
formatted. If you have a mixture of source documents that are inconsistently styled 
(some with named styles, some manually formatted), the default setting of None is 
your best choice.

! With None, Site Builder imports neither styles nor patterns. Rather, it uses a default 
set of ranks—Lowest 1, Title, Lowest 2, and Heading 1—to help ensure that all top-
level content in your source documents is styled in a consistent manner. You can 
supplement the default set of ranks with new ranks or patterns to help format unique 
portions of content.

! Generally, you should use paragraph patterns only if all your source documents are 
manually formatted, or where you can be sure of successfully identifying special 
content (for example, a bulleted or numbered list). Character patterns are always 
useful; indeed, three character patterns are included in every general-purpose template 
that ships with Site Builder: HTTP, Weblink, and Email. (You haven’t seen these in 
Element Setup thus far because the template you created wasn’t based on any of 
these general-purpose templates. See Appendix B, “Templates and Graphics Sets,” of 
the Getting Started manual for more information.) 

! Whatever setting you choose in the Choose Template dialog box will prevail across all 
projects until you change it again.

! If you select None in the Choose Template dialog box when you add a document to a 
publication and you later decide to import either styles or patterns from that document, 
the solution is simple: right-click the document in the Contents pane in the main 
window and choose Import and then Styles or Patterns from the popup menu.
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AN INTRODUCTION TO FORMATTING
In this lesson, you will learn how to

! Change font size, color, and alignment

! Add a separator

! Change character settings

KEY CONCEPTS
Once you’ve completed project setup and checked the assignment of elements in Element 
Setup, the next step is to decide how you want your Web page to look. You do this in the 
Formatting property sheet, setting instructions for each element, in turn. When the 
settings are saved to the template, they apply to every source document associated with the 
template. 

Once you start creating your own Web publications, you’ll find that most of your time is 
spent in Formatting. The wide selection of formatting options available include those that 
help structure your Web pages, as well as others that add color and graphics to 
dramatically change the look of those pages. 

EXERCISE
1. Open MyProjectFile.tcp.

2. In the Contents pane, select Source Documents.doc.
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Note: You actually select the whole line—the output page (.htm file), the source 
document, and the template. If you were to translate the source document and click 
View, your browser would recognize and open the output page. If you were to right-
click, Site Builder would recognize the source document and open a popup menu from 
which you could choose, for example, the Document Properties dialog box. Finally, if 
you click one of the template options (as you’re about to do), Site Builder will 
recognize the template file. 

3. Click Edit Template ( ) on the large toolbar, and then click Formatting to open 
that property sheet (see Figure 5-1).

On the left is the Elements list, which shows the list of elements for the template 
selected. This is the same list you saw in the Element Setup property sheet. It is 
available in Formatting from all tab dialogs. You open the tab dialogs by clicking the 
tabs across the top of the property sheet (if necessary, click the arrow buttons at the 
upper right of the property sheet to display additional tabs). Each tab dialog offers a 
series of formatting options. The Character tab dialog, which is used to format text, is 
open by default.

Figure 5-1 Formatting property sheet

Note: You can click on the arrow buttons at the upper right to display additional tabs.
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Let’s begin by formatting Title, the element associated with the first-level heading in the 
source document. To signify the title’s importance, we’ll apply a dark color, increase the 
font size and weight, and change the element’s alignment. All these will help to set off the 
title from the rest of the content. You will reinforce the title’s importance further by 
adding a separator.

Changing Formatting Attributes
To change color, font size, weight, and alignment, perform these tasks:

1. Select Title from the Elements list.

2. In the Character tab dialog, under Font Color, click Use this color, and click the 
Color button beneath it to open the Color dialog box.

3. Select a dark blue and click OK.

A sample of the color appears in the color box on the button, and a sample of text in 
that color appears in the box below.

4. Under Font Size, click Use this size. Then select Absolute size and 5, respectively, 
from the two drop-down lists.

5. Under Text Effects, click the Effects button to open that dialog box.

6. From the first drop-down list, opposite Bold, select Always On. Then click OK. 

The number you choose for size does not signify actual point size. Each Web browser 
has an option for a base font size. So the display size of a given font may differ, 
depending on the base font size of the browser. By setting the text to an absolute size, 
you have more control over the size of the text onscreen. 

Let’s format Heading 1 so that it will stand out, too, but not quite as much as Title.

7. From the Elements list, select Heading 1.

8. You’re still in the Character tab dialog. So repeat the steps above, this time setting the 
text color to a dark green and the absolute size of the font to 4.

Notice how easy it is in Formatting to stay in one tab dialog and select and format 
each element, in turn. Alternatively, you can move between tab dialogs in a property 
sheet as you complete the settings for a given element. It’s all a matter of what you’re 
trying to accomplish and how you prefer to work. 

Having set both color and font size for the Title and Heading 1 elements, let’s align 
the Title element. 

9. From the Elements list, select Title again.
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10. Click Paragraph to open that tab dialog. 

11. Under Alignment, click Use this alignment, and select Center from the drop-down 
list.

You have now centered the content associated with the Title element on your Web page. 
Placing a separator after the element Title will also help to set off the content associated 
with Title from the rest of the text.

Adding a Separator
To add a separator, perform these tasks:

1. With Title still selected in the Elements list, click Separators to open that tab dialog.

2. Check Insert separator after element.

Immediately, the full path and file name for the graphic Mroonspm.gif appears in the 
File Name text box, and the graphic itself displays in the Preview box. This happened, 
of course, because the graphic belongs to Maroon Sand, the graphics Set you selected 
as your default in Lesson 3. 

3. Under Alignment, make sure that Center is selected.

4. Click OK to leave Formatting.

You could have stayed in Formatting, because you are not quite done. But let’s 
quickly review the changes made thus far in the Preview window in Edit Template.

Note the new font size for Title and Heading 1, the use of bold for Title, the use of 
color, and the placement of a separator after the title. Now let us return to Formatting, 
to complete the final task we set ourselves in this lesson: changing character settings. 

5. Click Formatting to open the property sheet once again. 

This time you’re going to work with Introtext, the new element you created in Lesson 4. 
The content associated with Introtext is set in italic, and that’s how it will display in the 
Web page, too, unless you change it. Since whole paragraphs set in italic can be hard to 
read onscreen, you will change the element’s character settings.

Changing Character Settings
To change character settings, perform these tasks:

1. Click Character to open that tab dialog and select Introtext from the Elements list.
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Figure 5-2 Preview window in the Edit Template dialog box

The preview windows shows the introductory text associated with the Introtext 
element set in italic.

2. Under Text Effects, click Effects to open that dialog box.

Click the down arrow opposite each effect to review the drop-down list of options. In 
each case, From Source keeps the text the same as in the source document, Always 
On makes all the text associated with that element have that attribute, and Always Off 
prevents any text from having that attribute. 

3. From the drop-down list after Italic, select Always Off. Then click OK to return to the 
Character tab dialog.
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Figure 5-3 Effects dialog box

This dialog box has Italic set to Always Off for content associated with the Introtext 
element.

None of the text associated with this element will appear as italic in the Web page. You 
can confirm this by clicking OK to return to the Edit Template dialog box once again, to 
review this latest change.

Figure 5-4 Preview window in the Edit Template dialog box
5-6 Content Publisher: Seven Easy Lessons



An Introduction to Formatting
The preview windows now shows the introductory text associated with the Introtext 
element set in regular text, not italic.

You might care to try one more task before you finish this lesson. With the Edit Template 
dialog box still open, scroll down to the end of the source document. In a previous lesson, 
you will recall, we added the copyright line. We also noted that you could format this, if 
you wanted to. Here’s your chance.

4. Click Formatting ( ) to open the property sheet one more time.

5. From the Elements list, select Address (System).

You will recall from Lesson 4 that this element is used to format whatever information 
you place in the Address lines in the Address tab dialog of Globals. Experiment in the 
Character and Paragraph tab dialogs, changing the color, font size, and the alignment of 
the text. 

(By default, the <ADDRESS> tag is automatically assigned to the Address (System) 
element. As a result, content associated with this element will always display in italic 
because that’s how browsers interpret this tag. You can associate the element with the <P> 
tag, instead, if you want.)

When you are done, you should return to the main window and save your work. You can 
then translate and view your document. Only when you return to the main window, after 
clicking OK, have you, in fact, saved all your changes to the template.

6. Click OK in Formatting to return to the Edit Template dialog box (review your latest 
changes in the Preview window).

7. Click OK to return to the main window.

8. Click Save ( ) on the toolbar to save your template changes to the project file.

9. Click Translate ( ) on the large toolbar.

10. Click View ( ).

Now see the difference that formatting can make to the look of a Web page. With a few 
simple changes, you have dramatically altered the appearance of yours.

Note: The browser icon on the View button depends on your default web browser.
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SUMMARY
This lesson offered an introduction to the power of formatting that’s possible in Site 
Builder from the Formatting property sheet. The Character and Paragraph tab dialogs are 
especially important. You’ll spend most of your time in Formatting working in these. 
You’ll explore some of the other formatting options in the Tutorial. 

Tips
! Your changes in this lesson weren’t saved to the template until you clicked OK to 

leave the Edit Template dialog box. On the other hand, if you hadn’t opened Edit 
Template to begin with and had returned directly to the main window from 
Formatting, your changes would have been saved to the template as soon as you 
exited Formatting. So the rule is simple: keep clicking OK to save your changes. 
When you finally return to the main window, that’s when your changes are finally 
saved to the template. Of course, you should then save the template, and those 
changes, to the project file.

! Formatting options are significantly greater with CSS (cascading style sheets) turned 
on. Site Builder implements CSS by means of embedded, inline styles. For more 
information, see Lesson 2, “Formatting text with CSS,” in the Tutorial.
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ADDING A TOC
One of the advantages of Site Builder is its ability to automatically create a table of 
contents (TOC) for your publication. In this lesson, you will learn how to

! Create a TOC

! Promote content to the TOC

! Pick a graphics Set for the TOC

KEY CONCEPTS
The TOC you will create in this lesson is a publication TOC, which is one of five 
reference pages you can create in Site Builder (the others are List of Figures, List of 
Tables, Index, and Query). 

The publication TOC is different from the page TOC. Whereas the page TOC appears at 
the beginning of the Web page for the source document and is part of that page, the 
publication TOC is a separate Web page. And whereas the page TOC derives its content 
from a single source document, the publication TOC can derive its content from all the 
source documents in a publication. 

MyLesson is a simple publication, consisting of only one source document. So it doesn’t 
really need a publication TOC. But the steps you’ll learn in this lesson will help you create 
one (or another reference page) for larger publications. 
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EXERCISE

Creating a TOC
To create a TOC, perform these tasks:

Open MyProjectFile. When you create a reference page, you don’t need to select a source 
document in the Contents pane because you’re adding the reference page to the 
publication. To add the reference page:

1. Click Add Reference Page ( ) on the toolbar.

The Add Reference Page dialog box opens (see Figure 6-1).

2. Make sure that Table of Contents (TOC) is selected.

Note that the default title for the TOC displays in the Name text box, and the default 
template, Default TOC, displays below that.

3. Click OK to return to the main window.

Figure 6-1 Add Reference Page dialog box

The Contents pane (Figure 6-2) now displays the new output page for the Table of 
Contents, with the template name in the Template column. The TOC has no source 
document of its own, of course, because it will derive its content from Source 
Documents.doc, the source document for the publication. 

Note: Please note the default name for the Table of Contents and also the default template.
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Figure 6-2 Contents pane with the new reference page (Table of Contents)

Promoting Content to the TOC
To promote content to the TOC, perform these tasks:

Now that you’ve created the TOC, you must decide what content you want to place in it. 
You do this by “promoting” elements from the source document. By selecting which 
elements get promoted, you can control what goes into the reference pages you build. 

You’ll recall that we manage elements in the Element Setup property sheet. 

1. In the Contents pane, select Source Documents.doc and click Element Setup ( ) 
on the toolbar.

You’re in Element Setup once again, with the Elements tab dialog open. 

Typically, when you promote elements from source documents, you must then edit the 
reference page template to ensure that content associated with the promoted elements 
is actually placed in that reference page. However, Site Builder automatically 
promotes two elements to a publication TOC, should you decide to create one: 
Heading 1 and Title (System). You can tell this from the Promote As column in the 
Elements tab dialog (see Figure ). Moreover, Site Builder automatically includes the 
two promoted elements in the publication TOC, as we shall see.
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Figure 6-3 Elements tab dialog for the body page template

This Elements tab dialog for the body page template shows two elements promoted by 
default.

You can see that Heading 1 is being promoted as Heading 1, but that Title (System) is 
being promoted as Title. You have the option of promoting any element under a 
different name. By default, Title (System) is promoted as Title because the system 
elements are included in all the templates and the Table of Contents template will 
have its own Title (System) element. This special system element can be used to 
automatically create titles from information in your source documents. For a body 
page template, it consists of only the document title. (In the Titles tab dialog of 
Globals you can add other components to create a longer, more specific title.) 

Let us confirm the automatic promotion of two elements from the source document by 
editing the template for the Table of Contents. 

2. Click OK to return to the main window. In the Contents pane, select Table of 
Contents and open Element Setup once again.
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Figure 6-4 Elements tab dialog for the TOC template

This Elements tab dialog for the TOC template shows three elements included in the 
body of the TOC: Title (System) for the title of the TOC and the two promoted from 
the source document.

When you enter Element Setup with a reference page template selected, severalthings 
are worth noting (see Figure 6-4):

! The elements listed are those available for the TOC. They include the two 
elements promoted from the source document, as well as three “system” elements 
and two Default elements. 

! The Title (System) element here is for the Table of Contents. The default in the 
case of a reference page template is the publication title plus the document title. 
So “MyLesson Table of Contents” will appear at the top of the Web page. 

! Two elements are by default promoted from the TOC: Title (System) as Title, and 
Title as Heading 1. These would only be relevant if you were promoting TOC 
entries through several levels in a publication hierarchy. 

! The In Body column here refers to the TOC, not the source document. So 
whatever elements you select in the In Body column, you’re placing the content 
associated with those elements in the body of the TOC. In this case, they are 
Heading 1, Title (originally Title (System) in the source document), and Title 
(System) for the reference page. They all have green check marks after them in 
the In Body column. 

! The In Page TOC column is less relevant. A publication TOC can, in fact, have its 
own page TOC, and you might want to create one if the publication TOC is very 
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long and detailed. (It might be helpful to summarize the publication TOC by using 
only key elements in the page TOC.) But we don’t need it for our purposes.

3. Click OK to return to the main window.

4. Click Translate ( ) on the toolbar.

5. Select Table of Contents and click View ( ) on the toolbar.

Figure 6-5 Table of contents

This table of contents shows content associated with the three elements included in the 
body of the TOC.

You can see the content associated with the three elements selected in the In Body 
column: “MyLesson Table of Contents” is associated with Title (System) for the 
TOC, “Source Documents” with Title (originally with Title (System) in the source 
document), and “Size” plus the other two headings with Heading 1. 

You’ll learn more about promoting elements and creating titles in the Tutorial. For 
now, remember that once you have selected all the elements you want to appear in the 
TOC, you can then use Globals and Formatting to apply formatting just as you 
would to any source document template. Try that one on your own. 

Note: The browser icon on the View button depends on your default web browser.
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To finish this lesson, let’s pick a graphics Set for the TOC. What you will also have 
noticed in the Web page for the TOC (Figure 6-5) is how plain the page is. We can correct 
this by associating a graphics Set with the reference page template. So click OK to return 
to the main window.

Picking a Graphics Set
To pick a graphics set, perform these tasks:

1. In the Contents pane, with Table of Contents selected, click Globals ( ) to open 
that property sheet. 

2. Click Set to open that tab dialog. (Click one of the arrow buttons at the upper right, if 
necessary, to display the Set tab.)

3. Click Gallery to open the Gallery dialog box, and from the list of Sets, select Blue 
Bevel.

4. Click Make Default, and then OK.

5. Click Apply Set Selection, and click Yes when asked to confirm the Set.

You’ve now made Blue Bevel the default graphics Set for the TOC. However, you 
must still select the specific graphics from this Set you want to use for the TOC. An 
exception to this is the background graphic for the Set. Whenever you pick a Set and 
apply it, the background is immediately applied to all documents associated with the 
template. Let’s confirm this.

6. Click Colors to switch to that tab dialog. (Click the arrow buttons at the upper right to 
display additional tabs.)

Under Background Colors, Use a background graphic is already checked and the 
path and name of the graphic displays in the File Name text box. In addition, the 
background graphic can be viewed in the Sample box. This graphic came, of course, 
from the Blue Bevel Set. Site Builder automatically uses the background graphic 
whenever you associate a graphics Set with a template.

7. Click Separators to open that tab dialog, and click Insert separator after content. A 
graphic is selected immediately and displays in the Sample box.

You now have a background graphic in your TOC (automatically added by Site 
Builder) and also a separator at the bottom of the TOC (added by you).

8. Click OK to return to the main window. You have just saved these changes to the 
template.

9. Click Save ( ) on the toolbar to save your changes to the project file.
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Figure 6-6 The publication TOC for MyLesson

This publication TOC for MyLesson shows the background from the Blue Bevel 
graphics set and also a separator after the content.

10. Click Translate ( ) on the large toolbar.

11. With the Table of Contents still selected in the Contents pane, click View  on the large 
toolbar ( ). Your Web browser opens the Table of Contents.

SUMMARY
Let’s analyze the Web page for the Table of Contents you’ve just created so that we can 
appreciate all that’s happened.

First, the main title, “MyLesson Table of Contents,” is derived from the Title (System) 
element, which is a default element that appears in every template you create. It has two 
components. The first component, “MyLesson,” is a publication property. When you 
named your publication “MyLesson,” you also used “MyLesson” for the publication title. 
You can confirm this by right-clicking MyLesson in the Publication Hierarchy pane and 
choosing Properties from the popup menu to open the Publication Properties dialog box.

The second component, “Table of Contents,” is the default name you accepted in the Add 
Reference Page dialog box. Since it’s a document property, you can confirm this by right-

Note: The browser icon on the View button depends on your default web browser.
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clicking Table of Contents in the Contents pane and selecting Properties from the popup 
menu. The Document Properties dialog box will open. Since both titles are properties, you 
can change them at any time. 

Your Web page has a second title, “Source Documents.” Although this is the title in the 
content of the source document, which is associated with the Title element in the body 
page template, it actually comes from the Title element in the reference page template. 
That, of course, originated as Title (System) in the body page template. And by default, 
the Title (System) element in a body page template is simply the document title. The other 
three headings below Source Documents are content promoted because of its association 
with the Heading 1 element.

Finally, although your publication lacks navigation buttons (we’ll add them in the final 
lesson), your TOC is still linked to the source document because of the blue hot spot text. 
Click the title or any heading and you’ll jump immediately to the document. If you click a 
heading, you’ll go directly to that heading. So Site Builder not only picks up content from 
the source document to create a TOC, it automatically links that content to the source 
document. Site Builder does this for any reference page you create.

Tip
Three of the reference pages available in Site Builder actually work the same way: Table 
of Contents (TOC), List of Figures (LOF), and List of Tables (LOT). That is, you could 
add a LOF or LOT to your publication and create a TOC just as you would if you added a 
TOC in the Add Reference Page dialog box.

The Index derives its content from index markers in the source documents. So you can 
build an index only if the source documents contain index markers. The Index is therefore 
different from the three reference pages mentioned above, which derive their content from 
elements promoted from the source documents. 

The Query template is the final template available in Site Builder. It is a special template 
that can be used to generate queries of the Web site. 

By making a graphics Set the default for your template doesn’t mean you can use only 
graphics from that Set in your publication. In fact, you can choose any graphics you 
prefer, even with a Set associated with a template. The purpose of the Set is to help impose 
a consistent, professional design throughout your publication with minimum effort.
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ADDING NAVIGATION BUTTONS
In this lesson, you will add navigation buttons to

! Help readers jump from the bottom to the top of your Web page

! Link the source document to the TOC

! Link the source document to another Web page

KEY CONCEPTS
Navigation buttons perform an important role in Web pages, helping readers move within 
and between the pages of your Web publication. Site Builder simplifies the adding of 
navigation buttons by automating the selection process and speeding up the choice of 
graphics with the use of a default graphics Set. 

EXERCISE
1. Open MyProjectFile.tcp.

2. Select Source Documents.doc.

3. Click Navigation ( ) on the toolbar.

The Navigation property sheet opens with the Page Button Bar tab dialog 
in front (see Figure ). On the left is a list of the different types of links that Site Builder 
can create automatically. On the same line opposite each link are two red crosses to 
denote that you haven’t set any links yet. 
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To add navigation from the bottom of the page to the top

1. Under Link Type, select Top of Page. 

2. Double-click the second red cross, under After.

Under Link Icon, the path to the Top of Page button appears and the button itself 
displays in the Bottom of Page Preview window. You should recognize the style of the 
button. It’s from the Maroon Sand graphics Set you chose in Lesson 3 for the source 
document. That’s one of the benefits of having a graphics Set already selected. You 
don’t have to go hunting for a graphic each time.

By the way, the links you set on the Page Button Bar tab dialog all relate to the Web page 
as a whole. So Before and After refer to the top and bottom of the Web page, respectively. 

Adding Links to the TOC
Next you need to add a button to take you from the source document to the TOC. 
To add links to the TOC, perform these tasks:

! Select Table of Contents from the list of Link Types and place buttons at the top and 
bottom of the page by turning both the red crosses to green check marks (a double-
click will do it each time).

Figure 7-1 Navigation property sheet

This navigation property sheet shows the standard set of links you might want to use for 
any Web page.
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The TOC button from the graphics Set automatically pops up in both Preview windows, 
and the path to this button appears under Link Icon.

For some link types, such as Specific Page, you might need to choose a specific button. 
You do this in the Gallery.

Adding a Link to Another Web Page
To add a link to another Web page, perform these tasks:

1. Under Link Type, select Specific page 1 and change the red cross under After to a 
green check mark. 

The Home page button automatically appears. If you want to use a different button, 
click Gallery and select one from the Maroon Sand Set. 

2. Click the Properties button to open the Link Properties dialog box (see Figure 7-2).

Figure 7-2 Link Properties dialog box

Here you can enter a link for your Web page that will take you to any Web site.

3. In the Specific Page URL text box, type http://www.oracle.com, and click OK.

You have added a link to the Oracle home page. You can link to any URL anywhere in 
this manner, just as long as you enter the complete URL in the Specific Page Link text 
box. Look at the results in Figure 7-3.
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Figure 7-3 Navigation property sheet

This navigation property sheet shows the addition of navigation buttons to the source 
document.

This is all it takes to add navigation buttons to your Web page. Let’s see what you’ve 
accomplished.

4. Click OK to save your changes to the template and return to the main window.

5. Click Save  on the toolbar to save the template to the project file.

6. Click Translate  on the large toolbar.

7. With Source Documents.htm selected in the Contents pane, click View  to open 
your Web browser.

First you will notice the TOC button at the top of the page. Click and you’ll switch to the 
Table of Contents page. This page doesn’t have any navigation buttons as yet, so click 
Back on the browser toolbar to return to the source document. Now scroll to the bottom of 
this page and you’ll see three buttons. Top will take you to the top of the page you’re on, 
TOC will take you back to the TOC again, and Home will take you to, well, try it…

Before we close out this lesson, you might care to add similar navigation buttons to the 
Table of Contents. (In the Contents pane, select Default TOC and open Navigation.)
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SUMMARY
Navigation buttons are a powerful tool for ensuring that your readers can find their way 
around your Web publications with ease and always know how to get back to their starting 
point in the publication. The larger and more complex your publications are, obviously the 
more important navigation becomes. Navigation can also be accomplished with text bars 
(see the other tab dialogs in Navigation). Keep in mind, too, that Site Builder lets you 
create navigation links between elements as well as pages. 

Now that you’ve seen how simple it is to create a page button bar, you might want to 
experiment with the other tab dialogs available in Navigation before moving on to the 
Tutorial.
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A p p e n d i x

A.THIRD PARTY LICENSES

OVERVIEW
This appendix includes a description of the Third Party Licenses for all the third party 
products included with this product.

! Apache Software License (page A-1)

! W3C® Software Notice and License (page A-2)

! Zlib License (page A-4)

! General BSD License (page A-5)

! General MIT License (page A-5)

! Unicode License (page A-6)

! Miscellaneous Attributions (page A-7)

APACHE SOFTWARE LICENSE
* Copyright 1999-2004 The Apache Software Foundation.

* Licensed under the Apache License, Version 2.0 (the "License");

* you may not use this file except in compliance with the License.

* You may obtain a copy of the License at

*      http://www.apache.org/licenses/LICENSE-2.0

* 
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* Unless required by applicable law or agreed to in writing, software

* distributed under the License is distributed on an "AS IS" BASIS,

 * WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied.

 * See the License for the specific language governing permissions and

 * limitations under the License.

W3C® SOFTWARE NOTICE AND LICENSE
* Copyright © 1994-2000 World Wide Web Consortium, 

* (Massachusetts Institute of Technology, Institut National de 

* Recherche en Informatique et en Automatique, Keio University). 

* All Rights Reserved.  http://www.w3.org/Consortium/Legal/

* 

* This W3C work (including software, documents, or other related items) is

* being provided by the copyright holders under the following license. By

* obtaining, using and/or copying this work, you (the licensee) agree that

* you have read, understood, and will comply with the following terms and

* conditions:

* 

* Permission to use, copy, modify, and distribute this software and its

* documentation, with or without modification, for any purpose and without

* fee or royalty is hereby granted, provided that you include the following

* on ALL copies of the software and documentation or portions thereof,

* including modifications, that you make:

* 

*   1. The full text of this NOTICE in a location viewable to users of the

*      redistributed or derivative work.

* 

*   2. Any pre-existing intellectual property disclaimers, notices, or terms
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*      and conditions. If none exist, a short notice of the following form

*      (hypertext is preferred, text is permitted) should be used within the

*      body of any redistributed or derivative code: "Copyright ©

*      [$date-of-software] World Wide Web Consortium, (Massachusetts

*      Institute of Technology, Institut National de Recherche en

*      Informatique et en Automatique, Keio University). All Rights

*      Reserved. http://www.w3.org/Consortium/Legal/"

* 

*   3. Notice of any changes or modifications to the W3C files, including the

*      date changes were made. (We recommend you provide URIs to the location

*      from which the code is derived.)

* 

* THIS SOFTWARE AND DOCUMENTATION IS PROVIDED "AS IS," AND COPYRIGHT HOLDERS

* MAKE NO REPRESENTATIONS OR WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT

* NOT LIMITED TO, WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR

* PURPOSE OR THAT THE USE OF THE SOFTWARE OR DOCUMENTATION WILL NOT INFRINGE

* ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADEMARKS OR OTHER RIGHTS.

* 

* COPYRIGHT HOLDERS WILL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL OR

* CONSEQUENTIAL DAMAGES ARISING OUT OF ANY USE OF THE SOFTWARE OR

* DOCUMENTATION.

* 

* The name and trademarks of copyright holders may NOT be used in advertising

* or publicity pertaining to the software without specific, written prior

* permission. Title to copyright in this software and any associated

* documentation will at all times remain with copyright holders.

*
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ZLIB LICENSE
* zlib.h -- interface of the 'zlib' general purpose compression library

  version 1.2.3, July 18th, 2005

Copyright (C) 1995-2005 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied

  warranty.  In no event will the authors be held liable for any damages

  arising from the use of this software.

  Permission is granted to anyone to use this software for any purpose,

  including commercial applications, and to alter it and redistribute it

  freely, subject to the following restrictions:

  1. The origin of this software must not be misrepresented; you must not

     claim that you wrote the original software. If you use this software

     in a product, an acknowledgment in the product documentation would be

     appreciated but is not required.

  2. Altered source versions must be plainly marked as such, and must not be

     misrepresented as being the original software.

  3. This notice may not be removed or altered from any source distribution.

  Jean-loup Gailly jloup@gzip.org

  Mark Adler madler@alumni.caltech.edu
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GENERAL BSD LICENSE
Copyright (c) 1998, Regents of the University of California

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, 

are permitted provided that the following conditions are met:

"Redistributions of source code must retain the above copyright notice, this 

list of conditions and the following disclaimer. 

"Redistributions in binary form must reproduce the above copyright notice, this 

list of conditions and the following disclaimer in the documentation and/or other 

materials provided with the distribution. 

"Neither the name of the <ORGANIZATION> nor the names of its contributors may be 

used to endorse or promote products derived from this software without specific 

prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY 

EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 

WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. 

IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 

INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 

NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 

PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 

WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 

ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 

POSSIBILITY OF SUCH DAMAGE.

GENERAL MIT LICENSE
Copyright (c) 1998, Regents of the Massachusetts Institute of Technology

Permission is hereby granted, free of charge, to any person obtaining a copy of this 

software and associated documentation files (the "Software"), to deal in the 

Software without restriction, including without limitation the rights to use, copy, 

modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, 

and to permit persons to whom the Software is furnished to do so, subject to the 

following conditions:
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The above copyright notice and this permission notice shall be included in all 

copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, 

INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 

PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT 

HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF 

CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE 

OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

UNICODE LICENSE
UNICODE, INC. LICENSE AGREEMENT - DATA FILES AND SOFTWARE

Unicode Data Files include all data files under the directories 

http://www.unicode.org/Public/, http://www.unicode.org/reports/, and 

http://www.unicode.org/cldr/data/ . Unicode Software includes any source code 

published in the Unicode Standard or under the directories 

http://www.unicode.org/Public/, http://www.unicode.org/reports/, and 

http://www.unicode.org/cldr/data/.

NOTICE TO USER: Carefully read the following legal agreement. BY DOWNLOADING, 

INSTALLING, COPYING OR OTHERWISE USING UNICODE INC.'S DATA FILES ("DATA FILES"), 

AND/OR SOFTWARE ("SOFTWARE"), YOU UNEQUIVOCALLY ACCEPT, AND AGREE TO BE BOUND BY, 

ALL OF THE TERMS AND CONDITIONS OF THIS AGREEMENT. IF YOU DO NOT AGREE, DO NOT 

DOWNLOAD, INSTALL, COPY, DISTRIBUTE OR USE THE DATA FILES OR SOFTWARE.

COPYRIGHT AND PERMISSION NOTICE

Copyright © 1991-2006 Unicode, Inc. All rights reserved. Distributed under the 

Terms of Use in http://www.unicode.org/copyright.html.

Permission is hereby granted, free of charge, to any person obtaining a copy of the 

Unicode data files and any associated documentation (the "Data Files") or Unicode 

software and any associated documentation (the "Software") to deal in the Data 

Files or Software without restriction, including without limitation the rights to 

use, copy, modify, merge, publish, distribute, and/or sell copies of the Data Files 

or Software, and to permit persons to whom the Data Files or Software are furnished 

to do so, provided that (a) the above copyright notice(s) and this permission notice 

appear with all copies of the Data Files or Software, (b) both the above copyright 

notice(s) and this permission notice appear in associated documentation, and (c) 

there is clear notice in each modified Data File or in the Software as well as in 

the documentation associated with the Data File(s) or Software that the data or 

software has been modified.
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THE DATA FILES AND SOFTWARE ARE PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, 

EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, 

FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO 

EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR 

ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES 

WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF 

CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH 

THE USE OR PERFORMANCE OF THE DATA FILES OR SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not be used 

in advertising or otherwise to promote the sale, use or other dealings in these Data 

Files or Software without prior written authorization of the copyright holder.

________________________________________Unicode and the Unicode logo are trademarks 

of Unicode, Inc., and may be registered in some jurisdictions. All other trademarks 

and registered trademarks mentioned herein are the property of their respective 

owners

MISCELLANEOUS ATTRIBUTIONS
Adobe, Acrobat, and the Acrobat Logo are registered trademarks of Adobe Systems 
Incorporated.

FAST Instream is a trademark of Fast Search and Transfer ASA.

HP-UX is a registered trademark of Hewlett-Packard Company.

IBM, Informix, and DB2 are registered trademarks of IBM Corporation.

Jaws PDF Library is a registered trademark of Global Graphics Software Ltd.

Kofax is a registered trademark, and Ascent and Ascent Capture are trademarks of 
Kofax Image Products.

Linux is a registered trademark of Linus Torvalds.

Mac is a registered trademark, and Safari is a trademark of Apple Computer, Inc.

Microsoft, Windows, and Internet Explorer are registered trademarks of Microsoft 
Corporation.

MrSID is property of LizardTech, Inc. It is protected by U.S. Patent No. 5,710,835. 
Foreign Patents Pending.

Oracle is a registered trademark of Oracle Corporation.

Portions Copyright © 1994-1997 LEAD Technologies, Inc. All rights reserved.

Portions Copyright © 1990-1998 Handmade Software, Inc. All rights reserved.

Portions Copyright © 1988, 1997 Aladdin Enterprises. All rights reserved.
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Portions Copyright © 1997 Soft Horizons. All rights reserved.

Portions Copyright © 1995-1999 LizardTech, Inc. All rights reserved.

Red Hat is a registered trademark of Red Hat, Inc.

Sun is a registered trademark, and Sun ONE, Solaris, iPlanet and Java are trademarks 
of Sun Microsystems, Inc.

Sybase is a registered trademark of Sybase, Inc.

UNIX is a registered trademark of The Open Group.

Verity is a registered trademark of Autonomy Corporation plc
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